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Tutorial Document for Fracture Analysis with FCPAS 
 
Introduction  
 
In this tutorial, some basic linear elastic fracture mechanics examples are included that 
demonstrate usage of FCPAS (Fracture and Crack Propagation Analysis System) to solve three-
dimensional fracture problems. The generation of models, meshing and application of boundary 

conditions and loads are done using the commercially available finite element software, ANSYS . 
Then, a converter program is used to convert the finite element model information, boundary 
conditions and loads data from ANSYSTM [1] format into FCPAS format. Finally, FCPAS Solver is run 
to solve the crack problem and determine the stress intensity factors for the problem of interest. 
The following chart shows the general algorithm and file structure of process (Figure T.1).  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure T.1 General flow of the analysis process. 
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The steps from ANSYSTM model generation to solving the crack problem in FRAC3D are explained in 
detail. The problems included in this tutorial are: 

1. Two-dimensional mode-I central crack in a large isotropic medium, 
2. Mode-I crack in a Compact Tension, C(T) test specimen, 
3. Mode-I central crack in a finite-thickness plate. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

 

Figure T.2 General algorithm of FCPAS 

 
 
 
FCPAS’s GUI (Graphical User Interface) allows the user to follows the process in Figure T.3 in an 
orderly and user-friendly manner. This is the first version of the software and currently linear 
fracture analysis is available. 
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: If you click this button, you can work with 
Cracked Model Developed with ANSYS. 
 
 

: If you click this button, you can work with 
Crack Insertion and Fracture Analysis. 
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Figure T.3. FCPAS graphical user interface 

When you click first button, the above form comes up. 
  
 
EXAMPLE.1. Two-Dimensional Mode-I Central Crack in a Large Isotropic Plate 
 
T.1.1. Problem Description 
 
Consider the infinite domain in Figure T.4a containing a central crack and subjected to uniform 
tensile pressure loading perpendicular to the crack plane. We can model this problem as a plate in 
tension with a central crack as shown in Figure T.4b. Due to symmetry in the problem; only a 
quarter model is analyzed as shown in Figure T.4c. The plate is made of steel with Young's modulus 

E = 200 GPa and Poisson's ratio  = 0.33. Let width to be 2w = 20 m, height is 2h=20 m, a = 1 m and 

0= 1 Pa. The objective is to compute the mode-I stress intensity factor (SIF). 
 
 
 
 
 
 
 
 

GUI has tabbed interface, so it gives step by step. 

Once ANSYS, executable file is browsed and the path is included below, 

ANSYS would be runned using "Run ANSYS" button easily. 

Once ANSYS, executable file is browsed and the path is included below, 

ANSYS Product Launcher would be runned using "Run Product 

Launcher" button easily. 

Project folder is shown 

FCPAS folder on your computer is shown. 

Actual-instantaneose folder during run time is shown. 

To go to the "Geo File Tab". 

Control Panel. 
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   (a)     (b)     (c) 

Figure T.4 Through-thickness crack in a large plate. 

Note that for this problem, analytical solution is given by; 
 

aK 01 , where 0 = Stress (1 Pa), a: Half of crack length (1 meter).  Use of this solution yields 

KI = 1.77 Pa m. 
 
T.1.2 Assumptions 
 

 Linear elastic fracture mechanics (LEFM). 

 Plane strain problem. 

00
z

w
zz  

0),( yxzz   

 
In the ANSYSTM tab of the FCPAS, we browse “"C:\Program Files\ANSYS 
Inc\v120\ansys\bin\intel\launcher120.exe”. 
 
 The above directory location may change depending on the version of Ansys being used. 

 

 

h 2

h 

2w 

y 

x 

z 

h 

w 

a 

Symmetry  

BC 

Symmetry BC 

 

2a 

 

 



FCPAS Tutorial – Version 1.0 

 

 6 

 

Figure T.5 ANSYSTM tab of FCPAS. 

 
T.1.3   Generation of the Finite Element Model within ANSYSTM 
 
We will model this problem as a two-dimensional model plane strain model by taking into account 
the symmetries in horizontal and vertical directions. Also, in the out-of-plane direction, we will use 
one layer three-dimensional elements. To do this, we will first mesh the back face of the domain 
with area (2D) elements and extrude the mesh into the third direction. To do this, we will use 
PLANE82 and SOLID95 elements from the ANSYSTM element library. Note that ANSYSTM Help is very 
useful tool to identify and select the suitable elements for the problem of interest. 
 

 
 
 
 
 

 

Preprocessing 
Change Directory 
Before starting modeling, create a folder in which you would like to perform analyses & change 
directory to this folder. 

1- First, we browsed  ANSYS TM executable file with its parameters. 

Also, we may want to run ANSYS TM from its product launcher. 

2- To run, press it. 
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Give the Job a Name 
Utility Menu>File>Change Jobname ... 
Enter a name, for example `CC3', and click on OK. 

  

 

Define Element Type 
Main Menu>Preprocessor>Element Type>Add/Edit/Delete 
This brings up the 'Element Types' window. Click on the Add... button. The 'Library of Element 
Types' window appears. Highlight Plane 82 `Plane-8node 82' and solid95 `Solid-20node 95'. Click on 
OK or in command line, use (ET,1,82)1, (ET,2,95). 
 

 

 

Define Material Properties 
Main Menu>Preprocessor>Material Props>Material Models 
On the right side of the `Define Material Model Behavior' window that opens, double click on 
`Structural', then `Linear', then `Elastic', finally `Isotropic'. Enter in values for the Young's modulus 
(EX = 200E9) and Poisson's ratio (PRXY = 0.33) of the plate material. 

                                                        
1 PLANE82 element provides us both “plane strain or stress” options. 



FCPAS Tutorial – Version 1.0 

 

 8 

 
 

Define Keypoints 
Main Menu>Preprocessor>Modeling>Create>Keypoints>In Active CS 
We are going to create 5 keypoints given in the following table: 
 

Keypoints X [m] Y [m] Z [m] 

1 0 0 0 
2 10 0 0 
3 10 10 0 
4 1 10 0 
5 0 10 0 

 

 
 
 

Define Line Segments 
Main Menu>Preprocessor>Modeling>Create>Lines>Lines>Straight Line 
This is required to create the models boundary lines, successively like first 1 to 2, 2-3 and finally 5to 
1. 
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Create the Area 
Main Menu>Preprocessor>Modeling>Create>Areas>Arbitrary>By Lines 
Pick all lines (Click OK in the picking window. 
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EXTRUSION 
To create volume, we can use easily extrusion property by 0.1 unit through normal direction (z 
axes) 
Main Menu>Preprocessor>Modeling>Operate>Extrude>Areas>By XYZ Offset 
Firstly model is selected then entered the offset values. 
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Apply Boundary Conditions 
 
Because of the symmetry, our system has the following BC’s: 

 On symmetry areas   
o Left Area [from (0,0 ) to (0,10)] Ux =0 
o Top Area [from (10,10 ) to (1,10)] Uy =0 

 On back area, constrain Uz (Uz=0) 

 On front area, constrain Uz (Uz=0) 
 
Apply the displacement constrains using; 
Main Menu>Preprocessor>Loads>Define Loads>Apply>Structural>Displacement>Symmetry B.C.>on 
Areas> on back area and front area or DA, p for area BC. 
 

Top area 

Vertical left area 

Front area 

Back area 
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Be careful in selecting. To get accurate selection, you can use perspective views using ctrl+right 
buttons. 

 

 

 
To check the applied boundary conditions on areas, DALIST is used in the command line 
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Apply Loads 
 
Now we will apply the distributed surface forces (pressure).  
Main Menu>Preprocessor>Loads>Define Loads>Apply>Structural>Pressure>On Areas 
Carefully pick the bottom area (at z=0 and y=0) and then click OK in the picking window or sfa, p to 
apply area pressure. 
 
Select `Constant value' enter `-1' for `Load PRES value', then click OK (Negative sign is for tensile 
loading). 
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Meshing the Model 
 
Back area has to be meshed first. Before meshing, we can select the back area (template area) with 
ASEL command using the coordinate (location) option.  
 

 
 
 

 
In the above command, Asel is used to select a subset of areas that are located in the coordinate 
range specified. To be able to select the back area only, very small distance is given between the 
minimum and maximum coordinate in z direction only. 
 
asel, , loc,z,-0.001,0.001 
 
aplot 
 
Meshing 
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To obtain accurate fracture solution, we need to generate fine mesh near the crack tip. For this, we 
can use the KESIZE command to specify element size at the crack tip keypoint. First zoom into the 
crack tip region. Then issue the command  
kesize, p 
and pick the crack tip keypoint and write 0.01 as the element size value SIZE in the window. 

 
 

Amesh,p ' Select the back area exactly. Be careful in selecting. Use, zoom in, perspective view 
or rotate the model or issue other viewing commands to select the back area. 

 
 

 
 
First, zoom into the crack region and use Ksel to locate the exact location of the crack tip, since we 
will measure the element edge sizes ahead of and behind the crack tip. To do this, we use the ndist 
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command (ndist,p) and measure the crack tip edge size. This gives us 6.67e-1, which is coarser 
than the required size. Therefore, we require finer mesh. Now, we try a specified global element 
size. Esize,0.5 global size value is entered as 0.5. 
 

 
 

 
Mesh again the back area; Amesh,p 
 

 
 

 
We may check the distance again using the NDIST command. This gives us 9.972e-3, which is fine 
enough (i.e., 1/100th of the crack length). 
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As can be seen above, the specified element size is achieved. 
 
Volume Sweeping 
 
Now we will extrude the 2D mesh in to the third dimension by one element in this direction. 
 
Main Menu>Preprocessor>Meshing>Mesh>Volume>Volume sweep>Sweep 
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Volume scraping gives us prismatic mesh in the bounded volume, with respect to area mesh 
(template mesh). After sweeping the 2D mesh to generate the 3D mesh, we need to delete 2D 
elements, since FRAC3D requires 3D elements only. 
 
To do this, we use Aclear, all  ' Area mesh is deleted. Because of this, a gap occurs in the 
sequence of element numbers. To remove the gap we use, Numcmp, elem 
 

 

 
 
 
 

To make sure no gap exists in the node numbers as well, we use Numcmp, node 

Swept Mesh 
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Definition of Crack for FRAC3D 
 
Now, we need to provide crack tip element and node number information for FRAC3D analysis. 
Zooming into the crack region, we can find the elements and nodes located at the crack tip. (See 
detailed crack tip definition requirements in this tutorial for which elements and nodes to be 
selected). We need to identify the crack tip element on the bottom crack surface (with respect to 
the chosen local coordinate system) immediately behind the crack tip.  Using, Select-Entities-
Elements, form the main menu (or Esel, p command) try to select the elements at the crack tip. For 
this, move your mouse pointer near to crack tip region.  We have to select the element which is 
both at crack tip and on the bottom crack surface (as defined by the local coordinate system at the 
crack tip).  You can see that the crack tip element number is 1. 
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After element selection, we list the selected element and save the file FRAC3D analysis. Use Elist to 
see and save the list as a file. 
 

 
 
 

 
The element information (for the crack tip elements) is saved from the Elist window as cc3.crelems 

 
 
In addition to crack tip elements, we also need to select nodes on the crack front. To be able to 
select the nodes of the crack front, it is required to select the crack tip line and then select the 
nodes associated with this line. Using, Select-Entities-Lines, crack tip line is selected. Then, NSLL, S, 
1 is used to select all the nodes along the selected crack front line. Using Nlist, we can see that the 
crack front nodes numbers are:  122, 4299, 4454. 
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The coordinates of the selected nodes (the crack tip nodes) are saved from the Nlist window as 
cc3.crnodes  
 
Also using Select-Everything, all elements  in model are saved in file, cc3.elis. 
 

 
 

Also using nwrite all nodes are saved as cc3.node automatically in current working directory. 
 

 
 

SBCTRAN is used to transfer solid model loads and boundary conditions to the FE model. Loads and 
boundary conditions on unselected keypoints, lines, areas, and volumes are not transferred. 
sbct 
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Using dlist displacement BC’s are saved as cc3.dlis. 
 

 
 
Using sflist pressure loads on elements are saved as cc3.sflis. 
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Now, we completed all modeling steps in ANSYSTM. We are ready to convert all model information 
into FRAC3D format using the converter program. 
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T.1.4 Converting ANSYS Model into FCPAS Format (Generation of cc3.geo File) 
 
FCPAS requires its model information in a specific format. To convert ANSYSTM model files into 
FCPAS format, we can use the convert_ansys_fcpas.exe program. The converter program can be 
run by typing, its path in MSDOS prompt or from the “Geo File” tab from FCPAS GUI. 
 
 
 
Input file names can be selected by “Browse” buttons. “Generate Geo file” creates cc3.elis_3d.geo 
file. To go to Run File preparation, press “Next Step”. 
 
T.1.5  Generation of *.run File  
 
Now, we need to generate a run file which is also required for fracture analysis. We use 
writerun_fcpas.exe or FCPAS GUI to generate *.run file (cc3.elis_3d.run file). The *.run file contains 
analysis type, material properties, solver type tolerances, body forces and local coordinate systems 
data.  
 
Parameters can be selected by clicking the objects in the tab. “Generate Run file” creates 
cc3.elis_3d.run file.  
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To pass into “Frac3D” tab, press “Next Step”. 
T.1.6 Running FRAC3D (FCPAS Solver) 
 
To run the FRAC3D, three kinds of input files are required; 
 

*.run (compulsory) 
*.geo (compulsory) 
*.tem  (optional) 
 

FRAC3D gives the results in the following output files; 
 

*.out 
*.str 
*.stn 
*.crk 
 

Now, we are ready to run FRAC3D. To do this we can use frac3d.exe. When running FRAC3D, geo 
and run files names have to be entered. The following table shows the steps and input for this 
specific problem. 
 
 
Select the cc3.elis_3d.geo, cc3.elis_3d.run, and cc3.elis_3d.tem (if required) files by browsing and 
press run button to run the Frac3D.exe in the background.  
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 REVİEW EROR FİLE  toolu olan yeni görüntüyü al  
After finishing the process, output files can be seen in the “Fracture Info” tab. In the “Fracture 
Info” tab you can browse anyfile to see its content and plot the K1, K2 and K3 data in an x-y graph. 
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To plot the K1, K2 and K3 data in a graph, just press “Plot SIF’s” button. 
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We can see that the computed  K1 (1.814) is ~%2 higher than the analytical solution. 
 



FCPAS Tutorial – Version 1.0 

 

 30 

T.1.7 Post-processing of FRAC3D Results 
 
 

 
 
 
T.1.8 Visualization of FRAC3D Results 
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To see the Cracked Model results, choose the parameter you would like to contour plot and press 

“Show  Results” button. 
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EXAMPLE.2. Three-Dimensional Mode-I C(T) Specimen 
 
T.2.1. Problem Description 
 
Toughness is the ability of a material to resist fracture. The general factors, affecting the toughness 
of a material are temperature, strain rate, relationship between the strength and ductility of the 
material and presence of stress concentration (notch) on the specimen surface. Compact Tensile 
(CT) specimen is one specimen type to measure fracture toughness of a material. In this example, 
we will model a crack of length a=27.5mm in a CT specimen and compute the mode I stress 
intensity factor (SIF)  along the crack front. The material is Al-7075 with Elasticity Modulus = 70 

GPa, σY= 95 MPa, P= 1 N, = 0,33, = 2,81 g/cm3. The dimensions are given in Figure D.38. These 
dimensions are in mm. 
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Figure D.  2 CT specimen and its dimensions 

 
In FCPAS ANSYSTM tab, we run ANSYSTM program. 

22.5 
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Figure T.7. FCPAS graphical user interface 

 
T.2.2. Generation of the Finite Element Model within the ANSYSTM Preprocessor 
 
First of all, we must take into account the problem type, we will model this as a 3D problem. Also, 
due to the symmetry of the problem, only analysis of a half model is needed. We will model this 
three-dimensional problem using multi-layers of 3D elements in the out of plane direction. To do 
this, we will first mesh the back face of the domain with area (2D) elements and extrude the mesh 
into the third direction. We will use PLANE82 and SOLID95 elements from the ANSYSTM element 
library [3]. Note that ANSYSTM Help is very useful tool to identify and select the suitable elements 
for the problem of interest. 
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Preprocessing 
Change Directory 
Before starting the model, create a folder in which you would like to work&change directory to this 
folder. 

  
 
Give the Job a Name 
Utility Menu>File>Change Jobname... 
Enter a name, for example `CT2', and click on OK. 

  
 
Define Element Type 
Main Menu>Preprocessor>Element Type>Add/Edit/Delete 
This brings up the 'Element Types' window. Click on the Add... button. The 'Library of Element 
Types' window appears. Highlight “PLANE82-8 node 82”and “SOLID95-20 node 95”. Click on OK or 
in command line, use (ET,1,82)2, (ET,2,95). 
 
 

 
 
Define Material Properties 
Main Menu>Preprocessor>Material Props>Material Models 

                                                        
2 PLANE82 element provides us both “plane strain or stress” options. 
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On the right side of the `Define Material Model Behavior' window that opens, double click on 
`Structural', then `Linear', then `Elastic', finally `Isotropic'. Enter in values for the Young's Modulus 
(EX = 70E9) and Poisson's ratio (PRXY = 0.33) of the plate material. Or in command line, use 
 
MP,EX,1,70e9 
MP,PRXY,1,0.33 

 
 
Define Keypoints 
Main Menu>Preprocessor>Modeling>Create>Keypoints>In Active CS 
We are going to create 5 keypoints given in the following table: 
 

KEYPOINTS 
LOCATIONS  

X [m] Y [m] Z [m] 

1 0 0 0 

 

2 0.0625 0 0 

3 0.0625 0.03 0 

4* 0.04 0.03 0 

5 0.035 0.03 0 

6 0.0325 0.0275 0 

7 0 0.0275 0 

8** 0.0125 0.0165 0 

*: If  sharp crack length is 2 mm, then coordinates must be (0.037, 0.03, 0). In this case it is 5 mm. 
**: This keypoint is the center of the hole and going to be used in Hole (circle) placing section. 

K,1,0,0,0,   
K,2,0.0625,0,0,  
K,3,0.0625,0.030,0,  
K,4,0.04,0.03,0, 
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K,5,0.035,0.03,0,    
K,6,0.0325,0.0275,0, 
K,7,0,0.0275,0,  
K,8,0.0125,0.0165,0, 

 
 
Define Line Segments 
Main Menu>Preprocessor>Modeling>Create>Lines>Lines>Straight Line 
 
Clicking keypoints from 1 to 2, 2 to 3…, lines can be drawn. Last line must be KP7 to KP1. Keypoint 
8 is for only creating the hole. For now keypoint 8 will not be used. 
 

 
Or, 
LSTR,       1,       2   
LSTR,       2,       3   
LSTR,       3,       4   
LSTR,       4,       5   
LSTR,       5,       6   
LSTR,       6,       7   
LSTR,       7,       1 
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Create the Area 
Main Menu>Preprocessor>Modeling>Create>Areas>Arbitrary>By Lines 
Pick all lines (Click OK in the picking window). Or; 
FLST,2,7,4   
FITEM,2,1    
FITEM,2,2    
FITEM,2,3    
FITEM,2,4    
FITEM,2,5    
FITEM,2,6    
FITEM,2,7    
AL,P51X 
 

 
 
 
 
 
Hole (circle) placing 
 
Main Menu>Preprocessor>Modeling>Create>Areas>Circle>Solid Circle 
Click keypoint 8 and enter radius value as 0.00625m. Or; CYL4,0.0125,0.0165,0.00625 

Crack tip keypoint 
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Subtracting hole area 
Main Menu>Preprocessor>Modeling>Operate>Booleans>Subtract>Areas 
 
Firstly select the whole area and hit Ok then select the bigger area and click apply and then hole 
area that its center point is on keypoint8 is selected and click OK. Or use ASBA,       1,       2 and hit 
OK. 
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EXTRUSION 
To create volume, we can easily extrude the area by 0.025m in the normal direction (z axes) 
Main Menu>Preprocessor>Modeling>Operate>Extrude>Areas>By XYZ Offset 
First, model is selected then the extrusion distance is entered. 
 

 

 
Or; 
FLST,2,1,5,ORDE,1    
FITEM,2,3    
VEXT,P51X, , ,0,0,0.025,,,, 
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Meshing the Model 
 
Back or front area has to be meshed first. Before meshing we can select the back area (template 
area) with ASEL command using the coordinate (location) option.  
 

 
 
In the above command Asel is used to select a subset of areas that are located in the coordinate 
range specified. To be able to select the back area, very small distance is given between the 
minimum and maximum coordinate in z direction. 
 
asel, , loc,z,-0.001,0.001 
 
aplot 
 

 
 
To obtain accurate fracture solution, we need to generate fine mesh near the crack tip. For this, we 
can use the KESIZE command to specify element size at the crack tip keypoint. First zoom into the 
crack tip region. Then issue the command  
kesize, p 
and pick the crack tip keypoint on the back area and write 0.0005m as the element size value SIZE 
in the window. 
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Amesh,all ' Select the back area exactly. Be careful, in selecting. Use, zoom in, perspective view 
or rotate the model or issue other viewing commands to select the back area. 

 
For better meshing of the hole be must refinement using  
Main Menu>Preprocessor>Meshing>Modify Mesh>Refine At>Lines 
Use isometric view when you select hole edges. Choose 1(Minimal) value. 
 

Front Area 

Top Area 

Back Area 

Crack tip (back surface) 

0.0005 
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Note: All meshing and refining processes must be done in this stage. Because volume sweeping 
gives us hexahedral type volume mesh. Once volume sweeping is done, there is no way to return 
back to 2D mesh again, unless all mesh is deleted. Therefore all refinement and tuning processes 
on meshing stage must be finished at this point. 
 
Now, we will refine the hole circumference. When asked by the program select all lines on the hole 
circumference. 

 
 

 
We will do a minimum level of refinement. 
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Next, let us check the element size near the crack tip. First, zoom into the crack region and use Ksel 
to locate the exact location of the crack tip, since we will measure the element edge sizes ahead of 
and behind the crack tip. To do this, we use the ndist command (ndist,p) and measure the crack tip 
edge size. This gives us 4.8237299690E-04, which is fine enough. 
 

 
 
Note: If inter-node distances had not been done fine enough, we would have returned back to 
the refinement process again after cleaning the mesh. 
As can be seen above, the specified element size is achieved. 
 
Applying Boundary Conditions 
 
Because of the symmetry, our system has following BC’s: 

1. On symmetry area (Top Area):  [from (0.0225,0.03,0 ) to (0.0625,0.03,0)] Uy =0 
2. On corner 1, constrain Ux=Uy=Uz=0 
3. On corner 2, constrain Ux (to avoid the rotation about the Y axis. Note that: we could 

choose the corner 3 (Uz=0), instead.) 
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1. Apply the displacement constraint on symmetry area 
ALLSEL,ALL   
aplot    
Main Menu>Preprocessor>Loads>Define Loads>Apply>Structural>Displacement>Symmetry B.C.>on 
Area or DA, p for area BC. 
 
Symmetric area is top area of our model. This area must be constrained in y direction. Select the 
symmetry area carefully.  
 

 
 

  
Be careful, when selecting areas. To get accurate selection you can use perspective views using 
ctrl+right button. 

 
 

To check the applied boundary conditions on areas, DALIST is used in the command line 

“Corner3 

Corner1 

Corner2 

Symmetry Area 
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2. Apply the displacement constraint on corner 1, constraint Ux=Uy=Uz=0 
 

Main Menu>Preprocessor>Loads>Define Loads>Apply>Structural>Displacement>on Keypoints 
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To check the applied boundary conditions on areas and keypoints, DKLIST and DALIST is used in 
the command line 

  
 
3. Apply the displacement constraint on corner 2, constraint Ux  
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Main Menu>Preprocessor>Loads>Define Loads>Apply>Structural>Displacement>on Keypoints 
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Now let’s list the last BC’s. 
 

 

 
Or; 
DA,       5,SYMM 
FLST,2,1,3,ORDE,1    
FITEM,2,3    
FLST,2,1,3,ORDE,1    
FITEM,2,3    
!*   
/GO  
DK,P51X, ,0, ,0,UX,UY,UZ, , , ,  
FLST,2,1,3,ORDE,1    
FITEM,2,15   
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!*   
/GO  
DK,P51X, ,0, ,0,UX, , , , , , 
 
Volume Sweeping 
First, let’s define layer size for the mesh to extruded. 
Main Menu>Preprocessor>Meshing>Size Cntrls>ManualSize>Layers>Picked Line 
 

 

Select the on eline in z direction 
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Now we will extrude the 2D mesh in z direction and 20 layers will be generated in this direction. 
Main Menu>Preprocessor>Meshing>Mesh>Volume>Volume sweep>Sweep 

10 elements along the selected line. 
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Volume sweeping gives us prismatic mesh in the bounded volume, with respect to area mesh 
(template mesh). After sweeping the 2D mesh to generate the 3D mesh, we need to delete 2D 
elements, since FRAC3D requires 3D elements only. 
 
To do this, we use Aclear, all  ' Area mesh is deleted. Because of this, a gap occurs in the 
sequence of element numbers. To remove the gap we use, Numcmp, elem 
 
To make sure no gap exists in the node numbers as well, we use Numcmp, node 
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Applying Loads 
 
Now we will apply the pin loads on a line along inner surface of the hole. To do this, we can apply 
concentrated forces on nodes located on these lines (We can not apply concentrated forces on line 
entities). 
 
Main Menu>Preprocessor>Loads>Define Loads>Apply>Structural>Force/Moment>On nodes 
 
Carefully pick the nodes on the bottom line and then click OK in the picking window. 
 
NOTE: To do this in more easy way, we can use select, line and associating nodes on this line.  

   
 
nsll,s,1 
nplot 
This select all nodes associated with the line selected). Note that 41 nodes are selected (20 
layersx2+1). 
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Use menu-pltctrl-numbering and switch the nodes on to show the numbers of the nodes. 
 

 
 

 
Now we will apply the force to hole’s baseline.  
Main Menu>Preprocessor>Loads>Define Loads>Apply>Structural>Force/Moment>On nodes 
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Select Fy direction, constant value and enter “-1/41” for load value, then click OK. Note that;  force 
is applied on the 41 nodes. 
 

 
 
 
Select-everything. Eplot 
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Definition of Crack for FRAC3D 
 
Now, we need to provide crack tip element and node number information for FRAC3D analysis. 
Zooming into the crack region, we can find which element and which nodes are located at the 
crack tip. (See detailed crack tip definition requirements in this tutorial for which elements and 
nodes to be selected). We need to identify the crack tip element on the bottom crack surface (with 
respect to chosen local coordinate system) immediately behind the crack tip.  Using, Select-
Entities-Elements, form the main menu (or Esel, p command) try to select the elements at the 
crack tip. For this, move your mouse pointer near to crack tip region.  We have to select the 
element which is both at crack tip and on the crack surface.   
Vplot 
eplot 

 
 
 

 
 

 
Use menu-pltctrl-numbering and switch the nodes off to not show the numbers of the nodes. 
 

Crack tip 

immediately behind the crack tip 
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After element selection, we list the selected element and save the file for FRAC3D analysis. Use 
Elist to see and save the list as a file. 
 

 
 
The element information (for the crack tip elements) is saved from the Elist window as ct2.crelems 

Elements behind crack tip/front 

Elements in 

front of 

crack tip 

Crack tip 
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In addition to crack tip elements, we also need to select nodes on the crack front. To be able to 
select the nodes of the crack front, it is required to select the crack tip line and then select the 
nodes associated with this line. Using, Select-Entities-Lines, crack tip line is selected. Then, NSLL, S, 
1 is used to select all the nodes along the selected crack front line. Using Nlist, we can see that the 
crack front nodes numbers are:  18,2199,…. 
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NSLL, S, 1 
nlist 

 

 
 

The coordinates of the selected nodes (the crack tip nodes) are saved from the Nlist window as  
ct2.crnodes  
 

Select crack front line 
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Also using Select-Everything the whole element list is saved ct2.elis 
Allsll,all 
elist 

 
 
 
Also using nwrite all nodes are saved as ct2.node automatically in current working directory. 
 

 
 
 
SBCTRAN is used to transfer solid model loads and boundary conditions to the FE model. Loads and 
boundary conditions on unselected keypoints, lines, areas, and volumes are not transferred. 
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sbct 
 

 
 

 
 
Using dlist displacement BC’s are saved as ct2.dlis 
 

 
 
And using flist the nodal loads are saved as ct2.flis 
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Now, we completed all modeling steps in ANSYSTM. Now, we can save the model and close 
ANSYSTM. We are ready to convert all the model information into FRAC3D format using the 
converter program. 
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T.2.3. Using converter codes for FRAC3D (Generation of ct2.geo File) 
 
FRAC3D requires its model information in a specific format. To convert ANSYSTM model files into 
FRAC3D format, we can use the convert_ansys_frac3d.exe program. The converter program can be 
run by typing, its path in MSDOS prompt or from the “Geo File” tab from FCPAS. Both methods are 
shown respectively. 
 
T.2.3.1.   Using convert_ansys_frac3d.exe 
 
Run convert_ansys_frac3d.exe.  Using this exe file, we can obtain ct2.geo file, which contains 
element connectivity, nodal coordinates, boundary conditions, loads, and crack information. The 
following table shows the steps and input for the current problem. 
 

Input Element Connectivity FileName > ct2.elis 

Input Nodal Coordinate FileName > ct2.node 

Input Boundary Conditions FileName > ct2.dlis 

Input Nodal Forces FileName > ct2.flis 

Input Pressure Loaging FileName >  

Input Nodal Temperatures FileName > If there is any temperature file, it’s 
name is entered, otherwise hit return. 

Input the corresponding mesh ID from the below list 
1. 20 node quadratic- Hexahedorn (incl. mixed 
mesh) 
2. 15 node quadratic Pentahedron 
3. 10 node quadratic Tetrahedron 
4. 8 node linear Hexahedron 
5. 6 node linear Pentahedron 
6. 4 node linear Tetrahedron 

1 

How many cracks do you have? <Input 0 if no crack> 1 

Select an Option for Crack Front Information Input 
Input Files for Crack Front Nodes and Elements: 1 
Input Crack Front Nodes and Elements Interactively: 2 

1 

Input file name of file for Cr. Fronts Elements ct2.crelems 

Input file name of file for Cr. Fronts Nodes ct2.crnodes 

Input Coordinate Axis for Crack Front Node Order 
1 for X, 2 for Y or 3 for Z Coordinate... 

3 

Are There SIF Constraints on The Crack Front? (Def: n) y 

Is The Constraint Along The Whole Crack Front or on 
Specific Nodes? 
Along The Front: F, On Nodes: N 

f 

Input The Type of Constraint/K1: 1, K2: 2, K3: 3 2 

Input the Value of SIF 0 

Do you have a more SIF constrains? <Def:n>  Y Bu ifade mevcut değil 

Is The Constraint Along The Whole Crack Front or on 
Specific Nodes? 

f 
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Along The Front: F, On Nodes: N 

Input The Type of Constraint/K1: 1, K2: 2, K3: 3 3 

Input the Value of SIF 0 

Do you have a more SIF constrains? <Def:n> n 

Generating The FRAC3D .geo File, Please Wait ... Finalization Message 

 
 
T.2.3.2. Using FCPAS 
 

 
 
Input file names can be selected by “Browse” buttons. “Generate Geo file” creates ct2.elis_3d.geo 
file. To go to “Run File” preparation, press “Next Step”. 
 
 
 
T.2.4.   Generation of *.run FILE  
 
Now, we need to create a run file which is also required for FRAC3D. We use writerun_frac3d.exe 
or FCPAS to generate *.run file (ct2.run file). The *.run file contains analysis type, material 
properties, solver type tolerances, body forces and local coordinate data.  
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T.2.4.1   Using writerun_frac3d.exe  
 
The following table shows the steps and input for this specific problem. 

Input Run File Name without ".run" (Include "_3d") ct2.elis_3d 

Is This A Non-linear Analysis (y,n)?, (Default:n) N 

Is This A Thermal Stress Analysis (y,n)?, (Default:n) N 

Do you have temperature dependent material properties (y,n)?, 
(Default:n) 

 

Is This A Fracture Analysis? (y,n)?, (Default:n) y 

Please Choose a Solver Type ... 
Input "0" for Frontal Solver, "1" for PCG Solver' 

1 

Input the Tolerance for PCG Solver (1.E-8 Recommended)' 1.E-8 

Input Number of Different Materials in The Model, (Default:1) 1 

Input Ex, Ey, Ez, Gxy, Gyz and Gxz for Mat. Hit Enter 

Input Nuxy, Nuyz, Nuxz for Mat.# Hit Enter 

Enter CTE Values (XX,YY,ZZ) and Tref for Mat.#  

Input Number of Different Materials in the Model (Default:1  

Input Integration Order for Enriched Elements 24 

Do You Want to Use Transition Elements? (Default: n) Y 

Is This A Generalized Plane Strain Problem? (y,n) (Default: n) n 

Do You Have Other Tied DOF Sets? (y,n) (Default: n) N 

How Many Sets Do You Have?  

How Many Nodes to be Tied in Set#  

Input Node Numbers and Tieing Direction (x:1, y:2, z:3)  

How Many Nodes to be Tied in Set#  

Input Number of Increments, Max. Number of Iterations 
and Tolerance for Convergence(Default: 10, 20, 1.0E-6) 

 

Does Material#,NM, Exhibit Elasto-Plastic Behavior (y,n)? (Default:n)  

Input Initial Yield Stress and Number of Break-Points/Including The Initial 
Yield Stress 

 

Do You Want to Output The Results At The End of Every Increment? (y,n) 
(Default:y) 

 

Input Number of Increments for Which The Results To Be Printed  

Input The Initial Temperature  

Is Elastic Modulus of Material # Temperature Dependent? (y,n)  

Is Poisson',"'",'s Ratio of Material # Temperature Dependent? (y,n)  
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Input Temperature and The Corresponding Poiss. Ratio Value for Point #  

Is CTE of Material # Temperature Dependent? (y,n)  

Input Number of Temperature Points and Tref  

Input Temperature and The Corresponding CTE Values (x,y,z) for Point #  

Is Yield Stress of Material # Temperature Dependent? (y,n)  

Input Number of Temperature Points  

Input Temperature Value for Set #  

Input The Corresponding Yield Stress and Plastic Strain Values for Temp. 
Set #', i3,' Stress Point # 

 

Do You Have Body Force Loading ? (y,n), (Default:n) n 

Input Type of Body Force Loading ...'1: Gravity, 2: Centrifugal  

Input The Acceleration  

Input Direction Cosines of Grav. Loading Direction  

Input Density for Material #  

Input The Angular Velocity in Rd/Sec  

Input The x,y,z Coord.s of The 1st Point on The Rot. Axis  

Input The x,y,z Coord.s of The 2nd Point on The Rot. Axis  

Do You Have Local Coordinate Systems To Be Included In The Analysis 
(y,n)?, (Default:n) 

n 

How Many Coordinate Systems Will Be Defined?  

Do You Really Want to Exit ? (y,n)  

Input The Initial Temperature'  

Is Elastic Modulus of Material # Temperature Dependent? (y,n)  

Input Temperature and Elastic Moduli (Ex,Ey,Ez,Gxy,Gyz and Gxz) for 
Point # 

 

Is Poisson',"'",'s Ratio of Material # Temperature Dependent? (y,n)  

Input Temperature and The Corresponding Poiss. Ratio Values Nuxy, 
Nuyz, Nuxz for Point # 

 

Input Temperature and The Corresponding CTE Values (x,y,z) for Point #  

 
T.2. 4.2 Using FCPAS for *.run FILE 
Parameters can be selected by clicking the objects in the tab. “Generate Run file” creates 
ct2.elis_3d.run file.  
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To go to “Frac3D” tab, press “Next Step”. 
 
 
T.2.5 RUNNING FRAC3D 
T.2.5.1 Using frac3d.exe 
 
To run the FRAC3D, three kinds of input files are required; 
 

*.run (compulsory) 
*.geo (compulsory) 
*.tem  (optional) 
 

FRAC3D gives the results in the following output files; 
 

*.out 
*.str 
*.stn 
*.crk 
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Now, we are ready to run FRAC3D. To do this we can use frac3d.exe. When running FRAC3D, geo 
and run files names have to be entered. The following table shows the steps and input for this 
specific problem. 
 

Input Run File Name without ".run" ct2.elis_3d 

Input geo File Name without ".geo" ct2.elis_3d 

Input ter File Name without ".ter" Hit Enter 

 
As a result, *.crk file is created like this: 
 
 
 
                      FRACTURE MECHANICS INFORMATION      
 
     ct2.elis_3d.crk                                                                  
  24 X  24 X  24 INTEGRATION IS USED FOR ENRICHED CRACK TIP ELEMENTS 
                 TRANSITION ELEMENTS ARE INCLUDED IN THE ANALYSIS 
 
 
                              CRACK NO:   1 
     CRACK TIP NODES: 
          18   2200   2201   2202   2203   2204   2205   2206   2207   2208 
        2209   2210   2211   2212   2213   2214   2215   2216   2217   2218 
        5715   5716   5717   5718   5719   5720   5721   5722   5723   5724 
        5725   5726   5727   5728   5729   5730   5731   5732   5733   5734 
        2199 
 
     CRACK IN AN ORTHOTROPIC MATERIAL 
 
 
                K1                K2                K3 
 
   18     0.1643408E+04     0.0000000E+00     0.0000000E+00 
 2200     0.1789624E+04     0.0000000E+00     0.0000000E+00 
 2201     0.1939526E+04     0.0000000E+00     0.0000000E+00 
 2202     0.1971490E+04     0.0000000E+00     0.0000000E+00 
 2203     0.2004858E+04     0.0000000E+00     0.0000000E+00 
 2204     0.2033197E+04     0.0000000E+00     0.0000000E+00 
 2205     0.2061087E+04     0.0000000E+00     0.0000000E+00 
 2206     0.2078518E+04     0.0000000E+00     0.0000000E+00 
 2207     0.2095062E+04     0.0000000E+00     0.0000000E+00 
 2208     0.2108352E+04     0.0000000E+00     0.0000000E+00 
 2209     0.2120820E+04     0.0000000E+00     0.0000000E+00 
 2210     0.2130562E+04     0.0000000E+00     0.0000000E+00 
 2211     0.2139531E+04     0.0000000E+00     0.0000000E+00 
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 2212     0.2146679E+04     0.0000000E+00     0.0000000E+00 
 2213     0.2153085E+04     0.0000000E+00     0.0000000E+00 
 2214     0.2158029E+04     0.0000000E+00     0.0000000E+00 
 2215     0.2162254E+04     0.0000000E+00     0.0000000E+00 
 2216     0.2165264E+04     0.0000000E+00     0.0000000E+00 
 2217     0.2167572E+04     0.0000000E+00     0.0000000E+00 
 2218     0.2168789E+04     0.0000000E+00     0.0000000E+00 
 5715     0.2169318E+04     0.0000000E+00     0.0000000E+00 
 5716     0.2168789E+04     0.0000000E+00     0.0000000E+00 
 5717     0.2167584E+04     0.0000000E+00     0.0000000E+00 
 5718     0.2165264E+04     0.0000000E+00     0.0000000E+00 
 5719     0.2162278E+04     0.0000000E+00     0.0000000E+00 
 5720     0.2158029E+04     0.0000000E+00     0.0000000E+00 
 5721     0.2153123E+04     0.0000000E+00     0.0000000E+00 
 5722     0.2146679E+04     0.0000000E+00     0.0000000E+00 
 5723     0.2139585E+04     0.0000000E+00     0.0000000E+00 
 5724     0.2130564E+04     0.0000000E+00     0.0000000E+00 
 5725     0.2120897E+04     0.0000000E+00     0.0000000E+00 
 5726     0.2108353E+04     0.0000000E+00     0.0000000E+00 
 5727     0.2095165E+04     0.0000000E+00     0.0000000E+00 
 5728     0.2078529E+04     0.0000000E+00     0.0000000E+00 
 5729     0.2061253E+04     0.0000000E+00     0.0000000E+00 
 5730     0.2033191E+04     0.0000000E+00     0.0000000E+00 
 5731     0.2004985E+04     0.0000000E+00     0.0000000E+00 
 5732     0.1971658E+04     0.0000000E+00     0.0000000E+00 
 5733     0.1939746E+04     0.0000000E+00     0.0000000E+00 
 5734     0.1789692E+04     0.0000000E+00     0.0000000E+00 
 2199     0.1640899E+04     0.0000000E+00     0.0000000E+00 
 
 
                G1                G2                G3              GTOT 
 
   18     0.3858269E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2200     0.4575365E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2201     0.5373944E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2202     0.5552534E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2203     0.5742077E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2204     0.5905559E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2205     0.6068684E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2206     0.6171768E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2207     0.6270406E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2208     0.6350212E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2209     0.6425540E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2210     0.6484707E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2211     0.6539416E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2212     0.6583186E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 



FCPAS Tutorial – Version 1.0 

 

 71 

 2213     0.6622536E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2214     0.6652986E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2215     0.6679059E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2216     0.6697667E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2217     0.6711955E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2218     0.6719491E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5715     0.6722773E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5716     0.6719491E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5717     0.6712029E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5718     0.6697667E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5719     0.6679210E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5720     0.6652987E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5721     0.6622771E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5722     0.6583189E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5723     0.6539746E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5724     0.6484716E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5725     0.6426004E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5726     0.6350218E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5727     0.6271023E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5728     0.6171833E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5729     0.6069664E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5730     0.5905523E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5731     0.5742809E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5732     0.5553480E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5733     0.5375165E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 5734     0.4575709E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 2199     0.3846499E-04     0.0000000E+00     0.0000000E+00     0.0000000E+00 
 
 
T.2.5.2 Using FCPAS to run FRAC3D 
 
Select the ct2.elis_3d.geo, ct2.elis_3d.run, and ct2.elis_3d.tem (if required) files by browsing and 
press run button to run the Frac3D.exe in the background.  
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After FRAC 3D run ends, output files can be viewed in the “Fracture Info” tab. In the “Fracture Info” 
tab, you can browse anyfile to see its content and plot the K1, K2 and K3 data in an x-y plot. 
 
 
 
To plot the K1, K2 and K3 data, just press “Plot SIF’s” button. 
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KI value is Mode –I crack stress intensity factor along the crack front and depends on both load and 

crack geometry as follow (plane strain conditions) [4]; 
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PQ=Load as determined in P-v diagram, B=Specimen thickness, W=Specimen width, a=crack length.  
 

a [m] W [m] a/W f(a/W) B [m] Pq [MN] 
K1 

 

2.75E-02 5.00E-02 0.55 11.36428629 0.025 1.00E+00 2032.90533 
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Frac3D gives K1=2147  We can use the K1 value at the mid thickness location. Difference is 

%5.6 056.0
90533.2032

90533.20322147
 

 
 
T.2.6 POSTPROCESSING of FRAC3D Results Using movieassembly.f 

 
 
T.2.7  Visualization of FRAC3D Results 
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To see the Cracked Model results, choose the parameter you would like to contour plot and press 

“Show Results” button. 
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Appendix A    Definition of Crack in FRAC3D 
 

In fracture analysis of solid structures, FRAC3D uses special 3-D enriched crack tip elements. 
The enriched elements are defined as the finite elements that have common border with the crack 
front. In FRAC3D, the crack is defined by the nodes along the crack front and the enriched 
elements on the bottom crack surface (with respect to the local orientation of the crack tip). The 
current version of the program interacts with FRAC2D and the converter program determines the 
crack front nodes automatically. On the other hand, the enriched element numbers as reference 
elements along the bottom crack surface is needed. These element numbers must be added to 
next line after the crack tip node numbers (at the end of the *_3d.geo file) in the order that the 
crack tip node numbers are listed, i.e., from back face of the model to front face. Examples 1 and 2 
provided below explain the procedure. Alternatively, if 3-D *.geo file is prepared by translating the 
external list files from ANSYS (section 2.1.2 in this report), then users should prepare the crack tip 
node files and reference element files in ANSYS, the ANSYS-to-FRAC3D program would 
automatically add these fracture information into the *.geo file. Example 3 illustrated the 
definition of a curved crack tip. 

 
EXAMPLE 1 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

x’ 

y’ 

nel2d
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EXAMPLE 2 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

For the latter case, for example, the element number information shown in the rectangle 
must be added by the user to the “*_3d.geo” file as shown below. 
 
C*** FRACTURE MECHANICS DATA 
    1 
   10    120.00000000 
  431 2829 2830 1607 3455 3456 3101 4201 4202 3800 
  106  107  108 
 
C*** J-INTEGRAL PATHS 
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3-D 
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EXAMPLE.3.Two-Dimensional Mode-I Central Elliptical Crack in a Large Isotropic Medium 
 
T.3.1 Problem Description 
 
Develop a new problem case in the tutorial with the following data: A three-dimensional elliptical 

surface crack (a/c=0.3) in a finite-thickness plate under uniform tension with 2H x 2W x t (height x 

width x thickness), where H = W = 5c and t = 2a. compare your results from FRAC3D/FCPAS with 

those of Newman and Raju's surface crack formula. 
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In the ANSYSTM tab of the FCPAS, we browse “"C:\Program Files\ANSYS 
Inc\v120\ansys\bin\intel\launcher120.exe”. 
 

 
 

Figure T. 7 ANSYSTM tab of the FCPAS 
 
T.3.2 Generation of the Finite Element Model within the ANSYSTM Preprocessor 
 
 First of all, we must take into account the problem type, which is plane strain. Also, due to 
the symmetry of the problem, only analysis of a quarter model is needed. We will model this two 
dimensional problem using one-layer (in the out-of-plane direction) three-dimensional elements. 
To do this, we will first mesh the back face of the domain with area (2D) elements and extrude the 
mesh into the third direction. To do this, we will use PLANE82, SHELL 281 and SOLID95 elements 
from the ANSYSTM element library [3]. Note that ANSYSTM Help is very useful tool to identify and 
select the suitable elements for the problem of interest (Figure D.6). 
 
 
 
 
 
Preprocessing 
Change Directory 
Before starting the model, create a folder in which you would like to work&change directory to this 
folder. 

1- First, we browsed  ANSYS TM executable file with its parameters.  

2- To run, press it. 

Also, we may want to run ANSYS TM from its product launcher. 
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Give the Job a Name 
Utility Menu>File>Change Jobname... 
Enter a name, for example ` a_c_0.3' and click on OK. 

 

 
 
 
 
Define Element Type 
 
Main Menu>Preprocessor>Element Type>Add/Edit/Delete 
This brings up the 'Element Types' window. Click on the Add... button. The 'Library of Element 
Types' window appears. Highlight “PLANE82-8 node 95” Shell 281 and “SOLID95-20 node 93 95”. 
Click on OK or in command line, use (ET,1,95), (ET,2,93). 
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Define Material Properties 
Main Menu>Preprocessor>Material Props>Material Models 
On the right side of the `Define Material Model Behavior' window that opens, double click on 
`Structural', then `Linear', then `Elastic', finally `Isotropic'. Enter in values for the Young's modulus 
(EX = 200E9) and Poisson's ratio (PRXY = 0.3) of the plate material. 
 
MP,EX,1,200e9 
MP,PRXY,1,0.3 

 
 
Modeling 
Preprocessor-Modeling-Create-Volume-Block-By Dimensions 
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We must be choose the Workplane-offset WP with – keypoints on upper X Y surface 
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Ansys Command Prompt (lplot) 
 

 
 
Creating elliptic Crack 
Preprocessor-Modeling-Create-Lines-Arcs-By Cent & Radius  
First, we must create a circle r = 0.3 
  

 
 
 
Then we delete the lines by Delete-lines and below... 
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Preprocessor-Modeling-Operate-Scale-Lines 
We must select ¼ crack line and apply scale  
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We must be delete the quarter part of the circle ANSYS Command Line /repl. We offset to the 
workplane to the centure of the model  
 
And we use Workplane-Offset WP with – keypoints 
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And we use Offset workplane by increments  

 
Create Keypoints on Wp 
 
Preprocessor-Create-Keypoints-On Working Plane... 
 
We are going to create 5 key points given in the following table: 
 
 
 

Keypoints X(m) Y(m) Z(m) 

11 0 -0.03 0 

12 -0.03 -0.03 0 

13 -0.03 0 0 

14 -0.03 0.03 0 

15 0 0.03 0 
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Create Lines 
 
Preprocessor-Modeling-Creat-Lines-Straight Lines  
 
This is required to create the models boundary lines, successively like first 11 to 12, 12 to 13, 13 to 
14, 15 to 10, 10to 11 and finally 10 to 13..  
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Create Lines 
 
Preprocessor-Modeling-Creat-Areas-Arbitrary-By Lines 
 
Pick all lines (Click OK in the picking window). 
 

 
 
Preprocessor-Modeling-Operate-Extrude-Areas-Along lines  
First, we choose small areas and click Apply Button. After choosing line click Ok. 
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Ansys Command Prompt (lplot) 
 

 
 
 
and than Delete-Line and below choose the line  
 

 
 
 
 
Ansys Command Prompt (allsel) 
 

 
 
Ansys Command Prompt (nummrg,kp) 
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Ansys Command Prompt (aplot) 
 

 
 
Ansys Command Prompt (lsel,,p) Select line ın cevabı yok Komut ve resmi silinmeli 
 

 
 
Preprocessor-Modeling-Operate-Booleans-Substract-Volumes  
 
First we choose the all volume to pick apply and than select crack area to delete  
 
Ansys Command Prompt (vsbv,p) 
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Ansys Command Prompt (allsel) 
 

 
 
 
 
Ansys Command Prompt (vplot) 
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Ansys Command Prompt (lplot) 
 

 
 
Ansys Command Prompt (allsel) 
 

 
 
Ansys Command Prompt (nummrg,kp) (no keypoint were merged) 
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Ansys Command Prompt (vplot) 
 

 
 

 
 
 
 
 
Ansys Command Prompt (kesize,p) and we choose to WP  
 

 
 
To obtain accurate fracture solution, we need to generate fine mesh near the crack tip. For this, we 
can use the KESIZE command to specify element size at the crack tip keypoint. First zoom into the 
crack tip region. 
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Ansys Command Prompt (lesize,p)  
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Size Controls 
Preprocessor-Meshing-Size cntrls-Manual Size-Global-Others 
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Ansys Command Prompt (allsell) 
 

 
 
Ansys Command Prompt (lplot) 
 

 
 
 
 
Ansys Command Prompt (aplot) 
 

 
 
Ansys Command Prompt (vplot) 
 

 
 
 
 
 
Meshing The Areas 
 
Preprocessor-Meshing-Mesh-Areas-Free 
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Areas Sweep For Creating Crack Volume 
 
Preprocessor-Meshing-Mesh-Volume Sweep-Sweep 
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Ansys Command Prompt (aclear,all) 
 

 
 
We use Aclear, all ' Area mesh is deleted. Because of this, a gap occurs in the sequence of element 
numbers. To remove the gap we use, Numcmp, elem 
 
Ansys Command Prompt (eplot) 
 

 
 
Preprocessor-Meshing-Mesher Opts 
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Ansys Command Prompt (vplot) 
 

 
 
Preprocessor-Mesh-Volume-Free  
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Ansys Command Prompt (dalist) 
 
To check the applied boundary conditions on areas, DALIST is used in the command lineFme 
 

 

 
 
Ansys Command Prompt (da,p)  
 
Apply the displacement constrains using 
 

 
 
Apply Boundary Conditions 
 
Because of the symmetry, our system has the following BC’s: 
 
Select the all left X Y surface... (With small areas) 
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Ansys Command Prompt (da,p)  
 

 
 
Select the Y Z up areas but big area and the crack  one part... 
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Ansys Command Prompt (dk,p) 
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Ansys Command Prompt (numcmp,elem) 
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Ansys Command Prompt (numcmp,node) 
 

 
 
Ansys Command Prompt (sfa,p) 
Now we will apply the distributed surface forces (pressure). 
 

 
 
 
 
Select the Y Z area of down volume  
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Ansys Command Prompt (lplot) 
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Ansys Command Prompt (lsel,,p) 
 

 

 
 
 
Ansys Command Prompt (nsll,,1) 
 

 
 
Ansys Command Prompt (nlist) a_c_0.3crnodes 
The node information (for the crack tip nodes) is saved from the NLIST window as a_c_0.3.crnodes 
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Ansys Command Prompt (vsel,,p) 
 

 
 

 
 
Ansys Command Prompt (eslv) 
 

 
 
Ansys Command Prompt (esln,r) 
 

 
 
Ansys Command Prompt (eplot) 
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Ansys Command Prompt (elist) a_c_0.3.crelems 
The element information (for the crack tip elements) is saved from the Elist window as 
a_c_0.3.crelems 
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Ansys Command Prompt (allsell) 
 

 
 
Ansys Command Prompt (lplot) 
 

 
 
 
 
 
Ansys Command Prompt (aplot) 
 

 
 
Ansys Command Prompt (vplot) 
 

 
 
Ansys Command Prompt (eplot) 
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Ansys Command Prompt (sbct) 
 
SBCTRAN is used to transfer solid model loads and boundary conditions to the FE model. Loadsand 
boundary conditions on unselected keypoints, lines, areas, and volumes are not transferred. sbct 
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Ansys Command Prompt (modmsh,deta) 
 

 
 
 
Ansys Command Prompt (emid,add) 
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Ansys Command Prompt (eplot) 
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Ansys Command Prompt (nwrite) 
Also using nwrite all nodes are saved as a_c_03.node automatically in current working directory. 
 

 
 
 
Ansys Command Prompt (elis) a_c_0.3.elis 
Also using Select-Everything the whole element list is saved as a_c_0.3.elis 
 

 
 
 
 
Ansys Command Prompt (dlis) 
Using dlist displacement BC’s are saved as a_c_0.3.dlis 
 

 
 
Ansys Command Prompt (sflis) 
Using sflist pressure loads on elements are saved as a_c_0.3.sflis 
 

 
  

Now, we completed all modeling steps in ANSYSTM. Now, we are ready to convert all the 
model information into FRAC3D format using the converter program. 
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T.3.3 Using Converter Codes for FRAC3D (Generation of cc3.geo File) 
 FRAC3D requires its model information in a specific format. To convert ANSYSTM model files 
into FRAC3D format, we can use the convert_ansys_frac3d.exe program. The converter program 
can be run by typing, its path in MSDOS prompt or from the “Geo File” tab from FCPAS. Both 
methods are shown respectively. 
 
T.3.3.1 Using convert_ansys_frac3d.exe in FCPAS 
 
 Run convert_ansys_frac3d.exe. Using this exe file, we can obtain cc3.elis_3d.geo file, which 
contains element connectivity, nodal coordinates, boundary conditions, loads, and crack 
information. The following table shows the steps and input for the current problem.  
 
 

 
 
Input file names can be selected by “Browse” buttons. “Generate Geo file” creates cc3.elis_3d.geo 
file. To go to Run File preparation, press “Next Step”. 
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T.3.3.2 Generation of *.run file (writerun_frac3d.exe) using FCPAS 
Now, we need to create a run file which is also required for FRAC3D. We use writerun_frac3d.exe 
or FCPAS to generate *.run file (cc3.elis_3d.run file). The *.run file contains analysis type, material 
properties, solver type tolerances, body forces and local coordinate systems data. 
 

 
To pass “Frac3D” tab, press “Next Step”. 
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T.3.4   Running FRAC3D 
T.3.4.1 Using frac3d.exe 
 
To run the FRAC3D, three kinds of input files are required; 
 *.run (compulsory) 
 *.geo (compulsory) 
 *.tem (optional) 
FRAC3D gives the results in the following output files; 
 *.out 
 *.str 
 *.stn 
 *.crk 
Now, we are ready to run FRAC3D. To do this we can use frac3d.exe. When running FRAC3D, geo 
and run files names have to be entered. The following table shows the steps and input for this 
specific problem. 
 
 

Input Run File Name without ".run" a_c_0.3.elis_3d 

Input geo File Name without ".geo" a_c_0.3.elis_3d 

Input ter File Name without ".ter" Hit Enter 
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T.3.4.2 Using FCPAS to run FRAC3D 
 
Select the a_c_0.3.elis_3d.geo, a_c_0.3.elis_3d.run, and a_c_0.3.elis_3d.tem (if required) files by 

browsing and press run button to run the Frac3D.exe in the background. 

 

 
 
After FRAC 3D run ends, output files can be viewed in the “Fracture Info” tab. In the “Fracture Info” 
tab, you can browse any file to see its content and plot the K1, K2 and K3 data in an x-y plot. 
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To plot the K1, K2 and K3 data, just press “Plot SIF’s” button. 
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T.3.4.2 Post-processing of FRAC3D Results 
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T.3.5 Visualization of FRAC3D Results 
 
 
 
 
To see the Cracked Model results, choose the parameter you would like to contour plot and press 

“Show  Results” button. 
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K1 Comparison of Stress Intensity Factor: FCPAS and Newman_Raju 
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EXAMPLE.4.Crack Growth in Plate Using ANSYS Macro for Mode I 
 
In this example the aim is to get crack growth profiles by using written macros. A three-

dimensional elliptical surface crack in a finite-thickness plate under uniform tension with 2H x 2W x 

t (height x width x thickness). Plate dimensions are width: 0.175m, height: 0.295m, thickness: 

0.03m and also initial crack dimensional are crack length (c): 0.0196m , crack depth (a): 0.0144m. 

 
  
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
First we open FCPAS Cracked Model Development with ANSYS after click 3DCPP&C 
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After that we can ‘Select Propagation’ 
 

 
 
Change Working Directory 
 
Before starting to crack growth analysis create a folder in which you would like to work&change 

directory to this folder. 
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Give the Crack Propagation Project Name 
 
Enter a name, for example ‘Crack_propagation’  
 

 
 
 
 



FCPAS Tutorial – Version 1.0 

 

 129 

Choose ‘Ansys Path’, in this example 'ansys121.exe' should be chosen. 
 

 
 
 
In the following picture is shown that, before picking ‘Copy Macro’ button, the scheme has got 

project name and selected working directory. 
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When we select copy macro, specific prepared macro is copied from bin directory to working 

direction folder. At the same time, ‘Choose Areas of the Ellipse’ is enabled.  

 

 

 

Then ‘Plate And Crack Dimensions’ and ‘Material Properties’' are written. If you use transition 

element we check ‘Transition Element’ button. 

 

 
 
 
Terms of block is related to number of difference maximum crack advancement distance in a step 

along the crack front.(
maxa )If you would like to get more crack profiles, you can also go on by 

changing ‘Start Crack Front Number’ .Increment number is equal number of crack growth 

increment blocks. We write number of step is each value of (
maxa ) to obtain order again. At that 

time ‘Crack Lesize’ number of elements along crack front can be changed. 
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For the solve, click to ‘Start Crack Growth Analysis’. 
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‘Frac3d Solver’ 
 

 
 
After the crack growth analysis solution you can plot crack profiles click ‘Plot Crack Profiles’ button. 
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First we browse ‘ellipse_final.inp’ after select ‘step.inp’ to plot crack propagation profiles. 
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EXAMPLE.5. Crack Growth in Cylinder Using ANSYS Macro for Uniform Displacement Load 
(a/D=0.1, a/c=0.2) 
 
In this example, the aim is to get crack growth profiles by using written macros. A three-

dimensional elliptical surface crack in a cylinder under uniform displacement load with D x H 

dimensions. Cylinder dimensions are D=1, H=5, and also initial crack dimensions are crack length 

c=0.5, crack depth a=0.1 unit. 

 
D=1 
H=5 
a=0.1 
c=0.5 
∆amax=0.1, 0.2, 0.3, 0.4, 0.5 
 
 
 
We use symmetry of the fracture model. 
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First, we select “Cracked Model Developed using ANSYS” button. 
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Change working directory and write “Project Name”. 
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After we write “Project Name”, we select ANSYSTM path using “ANSYS PATH” button. 
 

 
 

 
 
 
 



FCPAS Tutorial – Version 1.0 

 

 138 

When we select “ANSYS Path”, “Copy Macro” button is enabled. We click “Copy Macro” button 
and copy cylinder displacement macro into the working directory. At the same time, when we click 
“Copy Macro”, “Choose x_ellipse” is enabled. 
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In this example, we select X and Y axes for ellipse fitting. 
 

 
 
We write cylinder and initial crack dimensions. 
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XR: Crack center coordinate. 
YR: Crack center coordinate. 
ZR: Crack center coordinate. 
Ø: Angle with X axes. 
 
Write material properties. 
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We click “Start Crack Growth Analysis” and crack growth analysis starts. 
Frac3D Solver 
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After solution, click “Plot Crack Profiles” button. 
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First, select ellipse_final.inp file from the working directory. 
 

 
 
Select step.inp file from the working directory. 
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Click “Plot Crack Profiles” button. 
 

 
 
You can see symmetry of the crack profiles. 
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It is also possible to get crack profiles using Microsoft Excel. 
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EXAMPLE.6. Plate Crack Insertion and Fracture Analysis 
 
We generate finite element model without crack using ANSYSTM Dimensions of plate are 2W=50 
mm, 2H=50mm, t=5 mm. Plate is subjected to uniform tension loading. 
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After we get finite ANSYSTM model without crack, we start to insert crack into the plate.In this 
example, a/t and a/c ratios are equal to 0.2. So, crack length (2c) is 5 mm. and also crack depth (a) 
is 1 mm. 
 
2W= 50 mm. 
2H= 50 mm. 
t= 5 mm. 
2c=5 mm. 
a= 1 mm. 
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First, we select “Crack Insertion and Fracture Analysis” button. 
 

 
 
 
Select “working directory” and *.node extension file, comes from ANSYSTM. 
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In this tab, we perform “Crack Insertion”. 

 Select *.node2 extension file using “Browse” button. 

 Give coordinates of crack center. 

 Chunk radius: Chunk is a volume that contains crack. 

 Give Crack Length, Crack Depth, Number of nodes along crack front and angles. 

 Click “ChunkSeperator” button and create chunk with crack. 
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Here, we write “Element edge length”. 
Click; 

 1)Run Tetgen  

 2)Unify Chunk – Original Meshes 

 3)Generate Quadratic Elements – Midside Nodes. 
 
Now, cracked finite element is ready to fracture analysis. 
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In “RUN File” tab, we select material properties. 
 

 
 
Fracture Analysis. 
“Frac3D Solver”. 

 
 



FCPAS Tutorial – Version 1.0 

 

 152 

Fracture Info and SIFs graphic. 
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Cut-views of near-crack-surface meshes 
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